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Science Software Inte gration
and Test (SSI&T) Overview

 WHAT ECS SSI&T IS

• SSI&T is the process by which science software developed by
Instrument Teams at local SCFs is tested and integrated into the
ECS at the DAACs.

• The scope of SSI&T for pre-launch releases covers activities starting
with delivery of the science software to the DAACs and ending with
either  the successful integration of each delivered PGE into ECS or
the scheduled end date for SSI&T support.

• SSI&T is a team effort which can only be successful in the allotted
time if all groups cooperate.
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Science Software Inte gration
and Test Overview

WHAT ECS SSI&T IS NOT

• SSI&T is not validation of science algorithms that are incorporated into
PGEs which produce science data products.

• SSI&T is not validation of the science data produced.
• Although the Operational Procedures are written as checklists of menu

driven activities, SSI&T is not a turnkey process which can be run by
test personnel who have no knowledge and experience related to
science software development and data processing.

• SSI&T is not a simulation of production.
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SSI&T Trainin g Objectives
Day 1

• Overall:  Provide the proficiency to integrate and test science
software into EOSDIS

– Version 2.0 Procedures
– The ECS Assistant
– Preparation and Setup - alias file
– Acquiring and Unpacking Delivered Algorithm Package
– Performing a DAP Acquire Using  SSIT Manager
– Science Software Configuration Management
– The SSIT Manager
– Standards Checking of Science Software
– Compiling and Linking Science Software
– Running a PGE in a Simulated SCF Environment
– Refer to the Post Processing and General Investigation
– Section for :

• Examining PGE Produced Log Files &
• File Comparison and Data Visualization
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SSI&T Trainin g Objectives
 Day 2

– Preparation of Earth Science Data Types
(ESDTs/DLLs)

– Production Rules
– DPREP
– Update the PDPS Database and Data Servers
– PGE Planning and Processing
– Post Processing and General Investigation
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SSI&T Process Overview - The
Big Picture

• Receive and Inspect New PGE and
Associated Software which includes:

•PGE Source Code & Status Messages
•Make File
•MCFs for Output files for each ESDT
•Shell Scripts and Instructions
•Process Control files.
•Input/ Output ESDT Descriptor files
•Input Test Granules

Science 
Software
Received

Planning and
Processing Team

• Prepare ESDTs (if
needed)

• Perform Standards
Checking on all files

• Make changes
• Compile/Link PGEs

to the SCF Toolkit
• Run and Profile PGE
• Perform file

comparison and
problem tracking.

SSIT Team

2

1

Receives and
controls using
ClearCase

3

4

• Register a Subscription for Test Input/Output files
• Submit a Production Request
• Create a new Production Plan
• Activate the Plan
• Monitor Production

SSIT Team

5

Configuration 
Manager

• Install ESDTs
• Register PGEs in

PDPS Database
• Install Input Files in

Data Server
• Build PGE with

DAAC Toolkit
• Run PGE  in PDPS
• Examine products

and output log files

Pre-SSIT

Formal SSIT
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Testbed and Version 2.0
Differences

VERSION 2.0 Architecture: Overview
ECS Subsystems
Client Subsystem (CLS)
Interoperability Subsystem “ADSRV” (IOS)
Data Management Subsystem (DMS)
Data Server Subsystem (DSS)
Ingest Subsystem “STMGT” (INS)
Data Processing Subsystem (DPS)
Planning Subsystem (PLS)
Communications Subsystem (CSS)
Management Subsystem (MSS)
Internetworking Subsystem (ISS)
Implications for SSI&T Procedural differences
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Major SSI&T Functions V2

Function
Release  VERSION 2.0

 System Operation All servers must run and 
communicate with each other; bring
 up manually, or use ECSAsisst tool.

 Ingest Ancillary Data Granules

  

Ingest GUI, ESDTs must  be visible
to ADV server.

 ESDT Insert Use Ingest

 ESDT Verification verify through ADV
 

DAP, SSAP Insert Use Ingest

PDPS Database Population More attributes, production rules

PGE Operation
  When all data is available; DPR
  activated.
  No automatic reprocessing
  Complex chaining through
  production rules.

File Access verify presence through ADV; ftp 
from SDSRV; access to multiple 

 sites

Multi-file Granule Support  Files inserted together, accessed as
 a single granule.

Subscription Management   Subscription Manager

Table 1.  Major SSI&T Procedures for Version 2.
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Management
(MSS)

Data
Server
(DSS)

Interoperability
(IOS)

Data
Management

(DMS)

Planning
(PLS)

User Registration, Order
Status, User Profile

Discovery/
Advertisements

Data

Documents/
AdvertisementsSearch

and
Access

Science
Software
and DataInsert

and
Retrieve

Data/Services

Acquire

Plans and
On-demand
Requests Data Processing

Requests

Communications(CSS)
and Internetworking (ISS)

Ingest
(INS)

External
Data Sources
and Providers

Archive
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The ECS Assistant

Using ECS Assistant to Start Up / Shut Down Servers

Subsystem Server Start Up / Shut Down

Monitoring the Distributed Computing Environment (DCE)

Using ECS to Perform System Monitoring

Using ECS Assistant to Open / View Log Files for a Selected Server

Using ECS Assistant to Monitor Server Status

Using ECS Assistant to Manage ESDTs
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ECS Assitant GUI
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Subsystem Mana ger GUI
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Server Monitor GUI
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cdspin g GUI



15
625-CD-016-002

Preparation and Setup

Preparation for SSI&T is a cooperative effort by M&O and SSI&T
• M&O Activities for Preparation and Setup:

• Setup of user accounts.
• Setup ClearCase VOB.
• Installation of Software Drops

• SSIT Preparation and Setup:
• Examine .cshrc file.
• Set additional environmental variables.
• Source additional setup files.
• Verify access to ClearCase VOB.
• The Green Book SSI&T Operational Procedures provides a road map

to get from a Delivered Algorithm Package to Science Software which
is integrated into ECS and ready for production.

• Procedures are ordered in a logical sequence.
• Some deviation will be required for actual work at each DAAC.
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Science Software Confi guration
Management

ClearCase - COTS tool for configuration management of science software.

Invocation Methods - Command line or Graphical User Interface (GUI).

Key Terms -
• Versioned Object Base (VOB) - a mountable file system which stores

version controlled data in directories and files.
- Any Unix file : source files, script files, documents, spreadsheets.
- Binary data and object files are not stored efficiently.
- Usually accessed with standard UNIX and ClearCase Tools.

• View - A working context for a user.  Used to access any VOB to make
files and directories visible and accessible.  Comprised of a storage
area  for checked out files.

• Element - File or directory in ClearCase VOB.



17
625-CD-016-002

Creatin g and Settin g a View

Naming Conventions
• Provides file/directory names for locating directories or files.
• Key Names

- ViewName - name of the user’s view.
- PathName - pathname is the path to the VOB directory.

Scope
• Needs to be created only once.
• Must be set at beginning of each user session.

Key Assumptions
• ClearCase is available.
• A VOB has been created.
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Creatin g a View

Access ClearCase by typing:
cleartool

Create a view by typing:
mkview -tag ViewName 
ViewPath/ViewName.vws

ViewName  = name of view 
ViewPath  = path to view directory
vws = file extension

View is created named 
ViewName  

> command line input
>
>
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Settin g a View

Access ClearCase by typing:
cleartool

Set a view by typing:
setview ViewName

ViewName  = name of view 

View  is set to ViewName
> command line input
>
>
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Enterin g a New Directory into
ClearCase

Key Assumptions
• A VOB and subdirectory has been created to hold the file
• A view has been created.

ClearCase Commands
• cleartool setview  ViewName  - Launches ClearCase and displays the

user’s view.
• cd PathName  - Changes directory to a subdirectory in the VOB.
• cleartool checkout  -nc  .   - Checks out a directory  from ClearCase.
• cleartool mkdir -nc  DirName   - Creates a new directory (subdirectory).
• cleartool checkin -nc DirName  - Checks new directory into ClearCase.
• cleartool checkin -nc  .   - Checks the current directory into ClearCase.
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Creatin g a Directory

Access ClearCase by typing:
cleartool setview ViewName

Checkout  directory  by typing:
cleartool checkout -nc  .

A new directory has been
created and checked into
ClearCase.

Change Directories by typing:
cd PathName

Create a new  directory  by typing:
cleartool mkdir - nc DirName

Checkin a directory  by typing:
cleartool checkin -nc DirName  

> command line input
>
>
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Enterin g a Single File into
ClearCase

Key Assumptions
• A VOB and subdirectory has been created to hold the file
• A view has been created.

ClearCase Commands
• cleartool setview  ViewName  - Launches ClearCase and displays the

user’s view.
• cd PathName - Changes directory to a subdirectory in the VOB.
• cp FilePath/FileName   .  - Copies file from current to VOB directory.
• cleartool checkout  -nc  .  - Checks out the current directory.
• cleartool mkelem -nc  FileName   - Creates a new element/file.
• cleartool checkin -nc  FileName  - Checks the file into ClearCase.
• cleartool checkin -nc  .   - Checks the current directory into ClearCase.
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Enterin g a Single File into
ClearCase

Access ClearCase by typing:
cleartool setview ViewName

Checkout  directory  by typing:
cleartool checkout -nc  .

Change Directories by typing:
cd Pathname

Create a new element  by typing:
cleartool mkelem -nc FileName

Checkin a file  by typing:
cleartool checkin -nc FileName

Checkin a directory  by typing:
cleartool checkin -nc  . 

> command line input
>
>
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Importin g Files into ClearCase

Key Assumptions
• DAAC SA required to complete this procedure.
• A VOB and subdirectory has been created to hold these files.
• No object files or executables exist in the directory.
• The PGE was received with a directory structure that contains various

types of files.
• The PGE directory structure will be maintained.

ClearCase Commands
• cd ParentDir  -  Changes directory to the parent directory of the

directory structure to be brought into ClearCase.
• clearcvt-unix -r DirName   - Creates a conversion script to import

everything in DirName  directory and everything below it to ClearCase.
• cvt_script  - Name of created script and command to run the script to

place all elements under ClearCase.
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Change directories to parent
of directory structure:

cd ParentDir

Importin g Multi ple Files into
ClearCase

The output script is named:
cvt_script

Create a conversion  script :
clearcvt-unix  -r DirName

Change directories in VOB by typing:
cd Pathname 

Copy files into ClearCase by typing
 the script:  cvt_script

> command line input
>
>
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Checkin g Out an Element from
ClearCase

Key Assumptions
• A VOB and subdirectory has been created to hold the file.
• A view has been created.

ClearCase Commands
• cleartool setview ViewName   - Launches ClearCase and displays the

user’s view.
• cd PathName   - Changes directory to a subdirectory in the VOB.
• cleartool checkout  -nc   .   - Check out a directory  from ClearCase
• cleartool checkout -nc  FileName   - Check out a file from ClearCase.
• cleartool uncheckout    - Cancels a checkout.
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Checkin g Out an Element from
ClearCase

Access ClearCase by typing:
cleartool setview ViewName

Checkout  directory  by typing:
cleartool checkout -nc  .

Change directories in VOB by typing:
cd Pathname 

Checkout  file  by typing:  cleartool 
checkout -nc  FileName  

> command line input
>
>
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Enterin g a Modified Element into
ClearCase

Key Assumptions
• A VOB and subdirectory has been created to hold the file.
• A view has been created.
• A file has been checked out from ClearCase and modified.

ClearCase Commands
• cleartool setview ViewName   - Launches ClearCase and displays the

user’s view.
• cd PathName  - Changes directory to a subdirectory in the VOB.
• cleartool checkin -nc FileName  - Checks a modified file into ClearCase.
Note
• DAAC policy may require a comment on entry of modified element into

ClearCase.
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SSI&T Process Overview - The
Big Picture

• Receive and Inspect New PGE and
Associated Software which includes:

•PGE Source Code & Status Messages
•Make File
•MCFs for Output files for each ESDT
•Shell Scripts and Instructions
•Process Control files.
•Input/ Output ESDT Descriptor files
•Input Test Granules

Science 
Software
Received

Planning and
Processing Team

• Perform Standards
Checking on all files

• Make changes
• Compile/Link PGEs

to the SCF Toolkit
• Run and Profile PGE
• Perform file

comparison and
problem tracking.

SSIT Team

2

1

Receives and
controls using
ClearCase

3

4

• Register a Subscription for Test Input/Output files
• Submit a Production Request
• Create a new Production Plan
• Activate the Plan
• Monitor Production

SSIT Team

5

Configuration 
Manager

• Install ESDTs
• Register PGEs in

PDPS Database
• Install Input Files in

Data Server
• Build PGE with

DAAC Toolkit
• Run PGE  in PDPS
• Examine products

and output log files

Pre-SSIT

Formal SSIT
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SSI&T PROCESS FLOW
DIAGRAM 1
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SSI&T PROCESS FLOW
DIAGRAM 2
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Type cd PathName

FTP Transfers files to the
desired directory within
the s sgi machine

Type ftp machine
IPaddress

Log into sgi
machine

SSIT Team

Note: Tapes are also used
to transfer files.  Usually performed
by the SA. 

Type user name
and password

Type cd PathName
where DAP is located

Type binary and
get DAPFilename

sgi machine
designated for SSI & T

Acquirin g the Delivered
Algorithm Packa ge by FTP



33
625-CD-016-002

Type cd
UnpackPathName

The tar  file is unpacked
in the desired directory
within the sgi machine.

DESTINATION:  INGEST

Type tar xvz
PackedDAP

Log into sgi
machine

SSIT Team

Unpackin g the Delivered
Algorithm Packa ge
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Delivered Al gorithm Packa ge

• Typical Contents of DAP:
•  Source code
• Message files.
• Make or build files.
• Shell Scripts
• Process Control File (PCF).
• Metadata Configuration File information to build an (MCF).
• Instructions for building and running PGE.
• New metadata and ESDT Descriptor files.
• Test data for input and comparisons.
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PGE07

MOD35_L2

MOD02HKM

MOD03

MOD10_L2

All files: 5 min data

Trainin g Example DAP
MODIS PGE07
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     Filename Description

SDSRV:
DsESDTMoMOD03.001.desc Input ESDT descriptor file
DsESDTMoMOD02HKM.001.desc Input ESDT descriptor file
DsESDTMoMOD35_L2.001.desc Input ESDT descriptor file
DSESDTMoMOD10_L2.001.desc Output ESDT descriptor file

libDsESDTMoMOD03.001.Sh.so Shared library for input ESDT
libDsESDTMoMOD02HKM.001.Sh.so Shared library for input ESDT
libDsESDTMoMOD35_L2.001.Sh.so Shared library for input ESDT
libDsESDTMoMOD10_L2.001.Sh.so Shared library for output ESDT

Trainin g Example DAP
             (1 / 3)
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Trainin g Example DAP
(2 / 3)

     Filename Description

PDPS:
PGE07.tar  PGE executable
PGE07.tar.met Target MCF for PGE executable
PGE_PGE07#1.0#01.odl ODL for PGE07
ESDT_ MOD03#2.0.odl ODL file for binary input granule
ESDT_ MOD02HKM#2.0.odl ODL file for binary input granule
ESDT_ MOD35#2.0.odl ODL file for binary input granule
ESDT_ MOD10_L2#2.0.odl ODL file for binary output granule
MOD02HKM.A1996218.1555.002.hdf Binary input data granule
MOD03.A1996218.1555.002.hdf Binary input data granule
MOD35_L2.A1996218.1555.002.hdf Binary input data granule
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   Filename Description

To be generated at run time:
MOD02HKM.A1996218.1555.002.hdf.met Target MCF for binary input granule
MOD03.A1996218.1555.002.hdf.met Target MCF for binary input granule
MOD35_L2.A1996218.1555.002.hdf.met Target MCF for binary input granule
MOD10_L2.A1996218.1555.002.mcf MCF for output product
MOD10_L2.A1996218.1555.002.mcf.met Target MCF for status

Trainin g Example DAP
              (3 / 3)



39
625-CD-016-002

SSIT Manager

Provides a common interface to the SSI&T software tools and
manages their operation

• Setup SSI&T Manager and checklist.
• Open xterm session.
• Code Analysis.
• Office Automation Tools.
• Standards Compliance.
• Product Examination using EOSView and  IDL.
• File Comparison in HDF,  binary or ASCII format.
• Edit Text file.
• Initialize and Update PDPS database.
• Data Server Access.
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Setup of SSIT Mana ger

Configuration of Environment
• SSIT Manager runs only on Sun platforms in the subsystem DPS
• User makes a local copy of a Process Control File (PCF) for SSIT

Manager and sample checklist.
• To setup the environment for the SSIT Manger, execute the

procedures steps tht follow: Note that in the following,
EcsCustomSW is normally in the directory /usr/ecs/TS1/CUSTOM on
the AIT Sun:  (This procedure was tested by telnet calahans, ID:
cmts1, pw: ecsu$er)

•   At a UNIX prompt on an AIT Sun, (type in:xhost +), then
setenv ECS_HOME /usr/ecs

-   cp /usr/ecs/{mode}/CUSTOM/data/DPS/EcDpAt.pcf
–   $HOME/mySSITpcf, press Return.
-   setenv PGS_PC_INFO_FILE $HOME/mySSITpcf, press Return.
-  check env for proper home path.
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-type cd /usr/ecs/mode/CUSTOM/utilities, press Return.
-setenv <mode>
-Type in: EcDpAtMgrStart <mode> &

¯This invokes the SSIT Manager GUI which should be displayed.

Setup of SSIT Mana ger 
           Continued
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Setup of Checklist for SSIT
Manager

Steps to Setup the SSIT Manager Checklist for Use in SSI&T
• From the SSIT Manager, click on the Tools menu, then choose Product

Examination, then EOSView.  The EOSView GUI will be displayed.
• Additional procedures are listed in the Training Manual vol 16.
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SSIT Manager GUI

Checklist Pane:
List set of steps
to be completed

Log Pane:
Log of activities
accomplished

Menu Bar:
Allows access to
SSI&T Tools 

Help: Provides
access to help
features

Edit: Button allows Checklist
 to be edited

Change State:
 Button allows 
Checklist state to
Toggle
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SSIT Manager Tools

1.  Xterm:  Starts an Xterm
     window session

2.  Code Analysis:   Performs 
     static code analysis

3.  Office Automation:  MS 
     Windows, MS Office, MS Excel

4.  Standards Checkers:   Prohibited Function
     & Process Control File Checkers, ForCheck,
      Prolog Extractor   
     
5.  Product Examination:  File Comparison Tools
      and EOSView
         
6.  Text Editors:  Emacs or Xedit Tools

7.  PDPS Database:   PCF ODL Template Tool,
     Science Metadata & Opnl Metadata Update  
     
8.  Data Serv er:  Register Subscription, Insert 
     Static, Insert Test Dynamic, Insert EXE TAR

Tools:
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Standards Checkin g

Purpose:  Verify that the source files of a PGE are compliant with the
ESDIS Data Production SCF Standards and Guidelines.
Key Terms:

• SDP Toolkit
- provides an interface to the ECS system.
- allows science software to be portable to different platforms.
- reduces redundant coding at the SCF.
- provides value added functionality for science software

development.
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 Standards Checkin g (cont.)

• Mandatory SDP Toolkit  Functions
- Error and Status Message Facility (SMF).
- Process control Tools.
- Generic Input/Output Tools.
- Memory Allocation Tools.

• Optional SDP Toolkit Functions
- Ancillary Data Access.
- Celestial Body Position Coordinate System Conversion.
- Constant  and Unit Conversion.
- IMSL.
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Standards Checkin g (cont.)

Steps for Standards Compliance

FORTRAN 77 -  On the AIT Sun.
    Source FORCHECK setup file.
    Create FORCHECK run script.
     Invoke FORCHECK run script.
     Examine the list file.
Fortran 90  and C - On the SDPS SGI.
     Set environment to appropriate SDP Toolkit.
     Compile the PGE using compiler flags.
     Examine the list file.
Ada - Compile using COTS Verdix Ada Development System or GNU C
Compiler, gcc.
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Prohibited Function Checker

•Used to check source files for the occurrence of functions that are
prohibited in the ECS DAAC production environment.

Key Procedure Commands
• SSIT Manager

- Tools → Standards Checkers → Prohibited Function Checker

Run the Analyze from GUI.
• Highlight files to be analyzed.
• Run checker.
• Generate report.
• Save and examine report.
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Prohibited Function Checker GUI

Highlight files to be analyzed.
Run checker.
Generate report.

main.c
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Checkin g Process Control Files

Key Procedure Commands.
• SSIT Manager

- Tools → Standards Checker → Process Control File Checker

Run the PCF Checker GUI.
• Select the directory

The PCFs must be checked to verify that they are syntactically correct and
contain all the information for the PGEs to run within the ECS DAAC
production environment.
Select one PCF and select the Check PCF button.

• Save or print the results file and examine results.
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Checkin g Process Control Files
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Compilin g and Linkin g Science
Software

Science software developed at SCFs using the SDP Toolkit provided by
ECS needs to be compiled and linked first with SCF Toolkit version to
compare results at each facility.  Then the science software needs to be
compiled and linked with the DAAC Toolkit .

Preparation for compile and link:
• Source correct SDP Toolkit library version - total of 8 versions.

- Location Type: SCF or DAAC
- Computer Language Type: FORTRAN 77, Fortran 90, C, Ada
- Object Type: 32-bit mode or 64-bit mode

• New and old 32-bit modes are distinguished by compiler options.
• Update PCF for execution of PGEs at the DAAC.
• Compile Status Message Files.
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Updatin g a PCF

PCF sections:
• System Runtime Parameters
• Product Input
• Product Output
• Support Input
• Support Output
• User-defined Runtime Parameters
• Intermediate Input
• Intermediate Output
• Temporary I/O

Update appropriate path names where necessary:
•  Add  10111|ShmMem|~/runtime||||1
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Extractin g Prolo gs

The Prolog Extractor will search recursively for files with valid filename
extensions.  The beginning and end delimiters are:

!F77  !F90  !C  !Ada  !F77-INC  !F90-INC  !C-INC  !PROLOG
!END

Key Procedure Commands:
• SSIT Manager

- Tools → Standards Checker → Prolog Extractor

Run the Prolog Extractor GUI.
• Select the directory with source files.
• Save or print the output Prologs files.
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Compilin g and Linkin g Science
Software

Science software developed at SCFs using the SDP Toolkit provided by
ECS needs to be compiled and linked first with SCF Toolkit version to
compare results at each facility.  Then the science software needs to be
compiled and linked with the DAAC Toolkit .

Preparation for compile and link:
• Source correct SDP Toolkit library version - total of 8 versions.

- Location Type: SCF or DAAC
- Computer Language Type: FORTRAN 77, Fortran 90, C, Ada
- Object Type: 32-bit mode or 64-bit mode

• New and old 32-bit modes are distinguished by compiler options.
• Update PCF for execution of PGEs at the DAAC.
• Compile Status Message Files.
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Updatin g a PCF

PCF sections:
• System Runtime Parameters
• Product Input
• Product Output
• Support Input
• Support Output
• User-defined Runtime Parameters
• Intermediate Input
• Intermediate Output
• Temporary I/O

Update appropriate path names where necessary:
•  Add  10111|ShmMem|~/runtime||||1
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Updatin g a PCF

Checkout directory and  file by typing:
cleartool checkout -nc  .
cleartool checkout -nc PCFFileName

Edit the  PCF.

Enter the vi editor by typing:
vi PCFFileName

After editing, re-run the PCF
Checker by selecting
Tools →Standards Checker → PCF
Checker and  from the SSIT menu.

Checkin the file  by typing:
cleartool checkin -nc PCFFileName

Checkin the directory  by typing:
cleartool checkin -nc  . 
 

> command line input
>
>
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Compilin g the SMF

Status Message Facility (SMF) Files - Also known as Error Status Message.
Provides:

• An error and status message handling mechanism
• A method to send log files, informational messages and output

data files to DAAC personnel or remote users.
SMF files need to be compiled with science software into message files
and include files.
These files will be used by science software during runtime.

• smfcompile -lang -f TextFile. t
• -lang is the computer language and TextFile .t is the SMF file.

Process Steps:
• Set ClearCase view (if source code is in ClearCase).
• Set up SDP Toolkit environment.
• Go to SMF directory for the PGE.
• Run the SMF compiler.
• Move created files to proper directories.
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Compilin g a PGE and Linkin g
with SCF and DAAC SDP

Toolkits
Compiling and Linking of Science Software will vary according to the
instructions from the Instrument Software Development Teams.
Compiling and linking with SCF and DAAC versions differs only in the
setting of the SDP Toolkit environment.

Process Steps:
• Read all instructional information supplied with the delivery.
• Log into the SDPS SGI and set up the proper SDP Toolkit

environment.
• Set the ClearCase view if software is already in ClearCase.
• Compile Status Message Facility files first.
• Examine the make or build file and alter if necessary.
• Using the make or build file, perform the build.
• If make file has been changed, check in modified version.
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Runnin g a PGE in a Simulated
SCF Environment

Running a PGE at the DAAC in a simulated SCF environment should
produce identical results as those at the SCF.

Process Steps:
• For SSI&T set up the SCF SDP Toolkit environment.
• For SSI&T Training set up the DAAC Toolkit environment (results will

be the same).
• Set the environment variable PGS_PC_INFO_FILE to path and file

name of PCF for the PGE.
• If the PGE has been run before in the same directory,  remove old log

files.
• Run the PGE from the command line.
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Runnin g a PGE in a Simulated
SCF Environment (cont.)

To capture PGE runtime statistics for the PDPS Database, perform profiling
using the DpPrRusage  Program (Rusage).

Statistics needed:
• wall clock time
• user time
• system time
• amount of memory used
• number of page faults
• number of input and output blocks
• number of swaps



62
625-CD-016-002

Examinin g PGE Produced Lo g
Files

PGEs produce three log files during runtime:
• Status Log - captures all error and status information.
• User Log - captures a subset of more informational messages.
• Report Log - captures arbitrary message strings.

Log file messages are written by both SDP Toolkit and science software
using the Status Message Facility (SMF).

Process Steps:
• Examine PCF to get location of log files.
• With SCF version of Toolkit, location and filenames can be set as

desired.
• Look for errors or warnings, anomalous messages
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File Comparison and Data
Visualization

An important activity for SSI&T is comparing the output data products from
the PGE runs to test files delivered with the PGE.

The comparison may consist of display of metadata in HDF files, display of
differences in data values,  or display of images of the data products.
Searches are performed for any differences beyond specified tolerances.

Data product files can be compared by a variety of tools accessible by the
SSIT Manager GUI.

• Tools → Product Examination → File Comparison → HDF or ASCII or
Binary

Data visualization tools are accessible by the SSIT Manager GUI.
• Tools → Product Examination → IDL or EOSView
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The Metadata Workflow

User/IT EOSDIS

Analysis

IT Specs

Population

MDWorks

PSA_Reg

Descriptor

ODL Parser

Validation

MCF Build

MCF Validated Desc.

DLL coding

Data/Docs

Tools

Tasks

Develop PGE

SDP Toolkit

Science Data Server

SSI&T

Sci. Software
  Delivery

  DAP

Test & Valid.

ESDT Insert

Constraints
check

ODL 
syntax
check

granule core values
PSA values
structural metadata

Data ModelMDWorks

collection core attributes + values
granule core attributes
PSA definitions

type and
format check

Responsibility
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Earth Science Data Types-
ESDT’s

• Representation of different types of data products from the
scientists perspective.

• Define to the Version 2 Data Model:
• Collection level metadata attributes and values.
• Granule level metadata attributes.
• Data services appropriate to the ESDT collection and data granules

within the collection.
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ESDT Components

Descriptor File:
• Collection level metadata attributes and values.
• Granule metadata attributes.
• Granule metadata attributes valid values.
• Services to be performed for the science data.
• The set of attributes in the granule level part of the descriptor  is

the source for producing a Metadata Configuration File (MCF).
From the MCF will be produced  a .met file using the SDSRV.

• DLL File:
• The Dynamic Link Libraries (DLL) file is uniquely produced for

each ESDT and must be installed with each ESDT.   
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Preparation of Earth Science
Data Types (ESDTs)

Building and installing ESDTs has been done before ECS is applied.
ECS Requirements:

• ESDTs for all data collections to be input to PGEs or output from
PGEs must be built and registered into ECS (SDSRV) before any
PGEs are run in PDPS.

• Version 2 uses ECS Assistant to install ESDT’s.
• Reasons for Inclusion in SSI&T:
• Instrument Teams may deliver new ESDTs for new types of input

files and output products from PGEs.
• NCR process for updates/changes to ESDT Descriptors.
• Some Ancillary input ESDT’s may be created by the DAAC’s in

the near term.
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MCF Generation from SDSRV

The Metadata Configuratrion File (MCF) is produced by the following
processes:

•    The ESDT’s  and DLL’s are installed into the SDSRV with error checking
taking place in the descriptor before installation.

•    The GETMCF tool is executed to pull the MCF from the SDSRV.  The
actual MCF is generated and then copied from the Inventory and Archive
section of the Collection Descriptor.
• 
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Descriptor, MCF & .met
Files

Metadata
  COLLECTION METADATA

  INVENTORY METADATA

  UNPARSED METADATA

Service

Structure

Event

INVENTORY METADATA

  UNPARSED METADATA

SDP Toolkit
Metadata Tools

INVENTORY METADATA

Descriptor File
MCF File

.met File
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What are Valids?

• Valids are type of integrity constraint to ensure that metadata values
comply with the data model and database schema requirements

• Valids are used to ensure the data products quality and consistency of
search queries

• Currently implemented for
- Data Type and Length checking; e.g. STRING, FLOAT, etc.
- Match Rules; e.g. DayNightFlag = (Day, Night, Both) ex: DAY will not

match, resulting in a failed insert.  (match rule is exacting)
- Range Checking ; e.g.

Longitude Minimum = -180.00   to
Longitude Maximum = +180.00

- Expressions; e.g. MinimumAltitude >= 0.0
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Attribute Valid Processin g

• Attribute Valids have dependency with corresponding Descriptors,
PGEs;  Versions must be “in-sync”

- Attribute Valids values may have a dependency upon  SDSRV
version and potentially other subsystems(Client & Ingest for
example)

- Changes to  Valids  may impact code ;  Versions must be “in-sync”
- Attribute Valids are  stored within SDSRV metadata database

• Incoming metadata validation processing is imbedded within the
SDSRV software

- Action on ESDT/granule with invalid metadata depends on
“MANDATORY=“ setting
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Attribute Valid Processin g
(Cont’d)

• Currently, incoming metadata checked against one of the 4 basic
constraints checks (Match, Range, Expression, or NONE) as specified

• “NONE” means no value checking is performed
• Messages are logged for attributes containing invalid data. Action on

ESDT/granule with invalid metadata depends on “MANDATORY=“
setting
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PSA Process

• Product Specific Attributes (PSA)  information is obtained from
Instrument Teams through a template (PSA Template) that has been
provided to them

• Data Engineering performs analysis to verify that the PSAs are unique
and conform to the Data Model

• Approved PSAs are submitted to the ECS CCB for approval to update
the PSA baseline

• PSA_Registry database is updated with the new approved PSAs
• Reports are generated on a bi-weekly basis or on as-needed-basis
• PSA reports are posted on the ESDT Bulletin Board (internal) and on the

ECS Web Page
- URL = http://ecsinfo.hitc.com/metadata/psatables.html
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ESDT CM Process

• Stored in ClearCase
• Directory structure is established to differentiate the different

versions of ESDTs
- Allows support of multiple versions of Database valids and

schema
- Allows for the creation of custom ESDT changes in order to

support the evolution of code development
- Makes delivery to different sites/platforms (mini-DAAC, VATC,

GSFC, etc…) easier
• Changes to ESDTs are based upon input from development, and

ITs
• Modified ESDTs are merged onto the baseline after approval at the

merge meetings
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Overview:  ESDT Development
and Installation Process

Complete ESDT development and installation process involves the
following steps:

• ESDT Generation
• ESDT Installation in the SDSRV

- Both the Descriptor and DLL are stored within the Science Data
Server

- From the Science Data Server, the attribute information contained in
the ESDT Descriptor is passed into a number of Clients as depicted
on the next slide (Adding a new ESDT)
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Addin g a new ESDT: Operational
Overview

DSS Admin/OPS :
Ensure CCB approval
Collect ESDT Descriptor &

ESDT DLL
Update Science Data Server
Update Advertising Server
Update Subscription Server
Update MSS

DSS Admin/OPS :
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Collect ESDT Descriptor &

ESDT DLL
Update Science Data Server
Update Advertising Server
Update Subscription Server
Update MSS

ESDT Developer:
Build  ESDT Components:
          ESDT Descriptor
                    Dictionary data
                    Service data
                    Event data
                    Validation data
          ESDT DLL

Science
Data Server

ESDT
DLL

ESDT
Descriptor

Metadata
Repository

DDICT
Export

New
ESDT

Implementation
Library
(DLLs)

Advertisements to Advertising

Events
to Subscription Serverto Subscription Server
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Required Servers

• Following servers need to be started and running before installing
ESDTs (with GDAAC machine names as examples):

- Science Data Server (SDSRV) (g0acs03)
- Storage Management Servers (STMGT) (g0icg01, g0drg01, g0dps02)
- Data Distribution Servers (DDIST)(g0dps02)
- Subscription Server (IDG) (g0ins01)
- Advertising Server (IOS) (g0ins02)
- Data Dictionary Server (IOS) (g0ins02)

• ESDTs (both components -- descriptor and corresponding DLL files) to
be installed must exist and must have been verified for syntax, valids,
and other metadata attributes correctness
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Data Server Subsystem:
Software Components

SDSRV
Science 

Data Server

STMGT
Storage
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Store Directive
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Metadata Flow in ECS

1.  Collection Metadata Values

2.  Granule Metadata Values

3.  Valid/Ranges for Product 
     Specific Attributes

4.  List of Services

Interoperability Subsystem

Data Management
 Subsystem

Data Processing Subsystem

Ingest Subsystem

Data Server Subsystem

1, 2, 3, 4

1, 4

1, 3, 4

2

2
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Tools - EcCoAssist
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Brin ging Up ECS Assistant

To Bring up ECS Assitant, execute the procedure steps that follow:

1 At the UNIX Console or Terminal type setenv DISPLAY ……:0.0,
To verify the setting, type echo $DISPLAY, press Enter.

 (type in: xhost <remote_workstation_name>) , press Enter.

2 Create an xterm by typing:  xterm -n hostname &

The hostname is the name of the machine on which the ECS Assistant is to
be displayed, i.e., the machine that your are using.

3 Log into one of the host machines used for SSIT,  ( Tested using
telnet texas), ID: cmts1, PW: ecsu$er.
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Brin ging Up ECS Assistant
continued

4 If necessary, at the UNIX prompt on the host from which the ECS
Assistant is to be run, type cleartool setview ViewName, press
Enter.

The ViewName is the ClearCase view to be used while the ECS Assistant is
running in this session. For example, type cleartool jdoe, press Enter.

A ClearCase view is required only if the ECS Assistant needs to be able to
“see” into a ClearCase VOB; a view is not necessary otherwise.

5 At the UNIX prompt, type cd /tools/common/ea, press Enter.
Then type:  EA, press Enter.

• /tools/common/ea is the path where ECS Assistant is installed.

This will invoke the ECS Assistant GUI with three push buttons for
selecting the proper activities, as indicated in the previous picture.
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ESDT Manager GUI



84
625-CD-016-002

Installin g an ESDT/DLL usin g
Science Data Server Operator GUI

Key Assumptions
• Your are logged into the SDSRV with the necessary servers listening.

- SSI&T personnel have permissions and privileges to register
ESDTs.

- Example:  telnet texas, login as opscm, pw: opsu$er, setenv
DISPLAY.

- Then log into: dce_login awhitele awhitele , setenv DISPLAY
- cd /usr/ecs/<mode>/CUSTOM/utilities/EcDsSdsrvGuiStart <mode>

.
- The SDSRV Operator GUI should now appear.
- The ESDT and DLL descriptor files can be installed from a specific

mode or by first copying into the selected mode those ESDT/DLL’s
- required for a particular PGE. Example:
-            DLL located: /home/emcleod/ESDT
-            ESDT Descriptors Located:  /home/emcleod/ESDT
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Installin g an ESDT/DLL usin g
Science Data Server Operator

GUI
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Installin g an ESDT/DLL usin g
Science Data Server Operator GUI

continued

Entering from Command Line

EcDsSdsrvGuiStart <MODE>.  This will bring up a GUI where you
can click on ADD.  Another GUI will appear “Add Data Type”.  Enter
the following:
Descriptor Filename:  Enter path to where ESDT is located,
including the full ESDT descriptor.

Archive ID:  enter DRP1_OPS:VG1
click on: OK
If added successfully, another GUI will appear saying …DataType
Successfully Added.

Verify installation by looking at the log:  path is - cd
/usr/ecs/CUSTOM/logs, type in: ls -lrt, to get the latest ALOG
entry.  type in: more EcDsScienceDataServer.ALOG to display same.
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Installin g an ESDT/DLL usin g
ECS Assistant GUI

Key Assumptions
• The ECS Assistant is up with the necessary servers listening.

- SSI&T personnel have permissions and privileges to register
ESDTs.

- The ECS Assistant GUI is running with ESDT Manager selected.
- The ESDT and DLL descriptor files are installed in the specific

mode.
-            DLL located: /usr/ecs/TS1/CUSTOM/lib/ESS
-            ESDT Descriptors Located:
-            /usr/ecs/TS1/CUSTOM/data/ESS
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Installin g an ESDT/DLL usin g
ECS Assistant GUI Continued

• Input a DLL path where the shared object files are located by typing a full
path name in the DLL Path window ”/usr/ecs/OPS/CUSTOM/lib/ESS”

• Select a subdirectory for the instrument team by clicking the
corresponding abbreviation.  (The Descriptor files installed for that
instrument will be listed.)

• Select descriptor files to be added to the archive by clicking the
       descriptor names in the list.  ( The selected descriptor files are

highlighted.)
• Move the selected files to the Selected Files window by clicking the “==>“

button.
• The short names for the selected descriptor files are listed in the Selected

File window.  (to add the selected file into the archive, click the ADD
button.)  Do this for each ESDT,  to exit, select Exit in the File pull-down
menu.
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Validatin g Successful ESDT
Installation

Criteria for success
• The SDSRV will display an event ID to the fact that a new ESDT has

been installed successfully.
• The following servers will also need to have acknowledged a

successful ESDT Event ID before additional work can be done:
• ADSRV, DDICT, & SBSRV.
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Production Rules Syntax
Overview

PGE Registration

PGE Registration ODL format

Production Rules

Rule Descriptions and Corresponding Syntax

Final Notes
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PGE Registration

• PGE Registration is the step during Science Software Integration and Test
(SSIT) that defines a PGE to PDPS.
• Information about the PGE is put into ODL (see next slide) files for
ingestion into PDPS.
• These files are read by SSIT software.  The data describing the PGE is
stored in the PDPS database.
• When the PGE is executed in the production environment, the information
in the PDPS database is retrieved to schedule the PGE for execution.  The
information tells PDPS when the PGE should be scheduled, what data
needs to be present to run the PGE, and what processing resources are
needed.
•This will be done by the SSIT Operators at the DAAC.  The Instrument
Teams may be asked to fill out a web page that describes their PGE so that
the SSIT operators can properly create the ODL files.
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PGE Registration ODL format

• ODL is simply a parameter=value file format.  Each line in the file (except for
comments) is of the form:  parameter = “value”

There are currently 5 types of ODL files that need to be
specified for PGE registration.

- The first defines the PGE itself and is called the PGE metadata.  This
contains information about the PGE, its name, instrument, schedule
type, as well as definitions of its inputs and outputs.

- The second defines any ESDTs that the PGE uses (as input or output)
and is called the ESDT metadata.  This describes the data that a PGE will
use.  Note that there will be one of these files for every ESDT used by the
PGE.

- The third defines the Tile definitions.  It is only needed for those PGEs
who are “Tile Scheduled”.

- The fourth defines the Orbit times for the platform of the instrument for
which the PGE is run.  This is only required if the PGE wants to run on
during specific orbits of the spacecraft or process data based on those
orbits.

- The fifth defines the mapping of path numbers.  It is only required for
PGEs that require path numbers for runtime parameter values

- or metadata queries.
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Production Rules

Provide a template for Instrument Teams to describe the relationship(s)
between the PGEs and the input and output data.  These specifications
cover a variety of issues such as:
Basic Temporal specification

• Advanced Temporal specification
• Alternate Inputs
• Optional Inputs
• Metadata-based PGE activation
• Metadata Query
• Intermittent execution
• Special Level 0 processing needs (Orbital Processing)
• Tiling
• Data Day
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Basic Temporal

Production Rule Information Needed for PGE Registration:
• PGE Schedule Type is “Time Scheduled”
• Boundary and Period of PGE are specified.

Run 24 hourly PGEs
using the daily input
granule

  Input Dataset PGE-1 Output Datasets

Specify temporal range of inputs that matches temporal range of outputs.
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“Time Scheduled” ODL Files and
Parameters

The following information needs to be filled out in the PGE  metadata  file:
• Schedule_Type = “Time”
• Processing_Boundary = <time boundary on which PGE runs>
• Processing_Period = <interval between PGE runs>

The Boundary and Period will normally match the expected length and
start time of the input data for the PGE. For a PGE that runs on 24 hours
worth of data, the Boundary/Period would be set to:
 Processing_Boundary = “START_OF_DAY”
• Processing_Period = “DAYS=1”
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“Time Scheduled” ODL Files and
Parameters (CONT)

The following information needs to be filled out in the ESDT  metadata  file
(for each ESDT that comes from an external source):
• Boundary = <time boundary on which data is collected>
• Period = <interval of data collection>

Data from an external source is periodic data that is not produced by PGEs
at the local DAAC.  For data that comes in every 2 hours (such as EDOS
data):
 Processing_Boundary = “START_OF_DAY”
• Processing_Period = “HOURS=2”
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Advanced Temporal

Specify temporal range of inputs with offsets from expected temporal
range of inputs and outputs.

Run 24 hourly PGEs
using the daily input
granule

  Input Dataset PGE-1 Output Datasets

Input should be for
pervious time period 
for extrapolation

Production Rule Information Needed for PGE Registration:
• PGE Schedule Type is “Time Scheduled”
• Boundary and Period of PGE are specified as if Basic Temporal.
• Offsets are specified for data that is to be retrieved for another time

period.
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“Advanced Temporal” ODL Files
and Parameters

The following information needs to be filled out in the PGE  metadata  file for
each input Data Type (PCF Entry) that is to have a timeframe different from
the PGEs output:
• Begin_Period_Offset = <number of seconds to add (+) or subtract (-) from
the start collection time when requesting data>
• End_Period_Offset = <number of seconds to add (+) or subtract (-) from
the end collection time when requesting data>

If the PGE runs every hour and desires data for the pervious hour and the
current hour (2 granules):
• Begin_Period_Offset = -3600
• Processing_Period =0
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Alternate Inputs

Production Rule Information Needed for PGE Registration:
• Schedule Type and corresponding data.
• Alternate Input Objects for inputs that have alternates.

Required Dataset

Primary Dataset

First Alternate

PGE-1

< or  >
ideal Dataset - wait
up to 3 hours after
required Datasets
available

use after 3 hours if
primary alternate
not available

Output Dataset

Second Alternate

< or  >

use after 3 hours if
primary and
second alternates
not available

Run PGEs with different inputs based on availability
or quality of various alternate input data sets.
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“Alternate Input” ODL Files and
Parameters

The following information needs to be filled out in the PGE  metadata  file for
each Data Type (PCF Entry) that is or has Alternate Inputs:
• Input_Type = “Primary”
(This is the Primary -- First Choice -- Alternate)
• Input_Type = “Alternate”
(This is for every other Alternate)
• Object = Alternate_Input
•     Category = <name of list of alternates; same for every alternate in the
list>
•     Order = <number indicating which alternate comes first, second,…>
•     Timer = <number of days/hours/seconds to wait for alternate>
•     WaitFor = <should we wait for this alternate; should be false for all but
the last alternate in the list>
•     Temporal = <does this alternate data type have temporal component>
• End Object = Alternate_Input
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Optional Inputs

Run PGE with specified inputs if available; otherwise run PGE
without them.

Required Dataset

Optional Dataset

PGE-1

wait up to 2 hours after
required Datasets
available, then run 
without

Output Dataset

Production Rule Information Needed for PGE Registration: 
• Schedule Type and corresponding data.
• Optional Input Objects for inputs that are optional.
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“Optional Input” ODL Files and
Parameters

The following information needs to be filled out in the PGE  metadata  file for
each Data Type (PCF Entry) that is an Optional Input:
• Input_Type = “Optional”
• Object = Optional_Input
•     Category = <name of list of optionals; same for every alternate in the
list>
•     Order = <number indicating which optional comes first, second,…>
•     Timer = <number of days/hours/seconds to wait for optional>
•     Temporal = <does this optional data type have temporal component>
• End Object = Optional_Input
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Metadata-based PGE Activation

PGE-1 Output Dataset

Run PGE if QA flag
set to acceptable
value

  Input Dataset

Production Rule Information Needed for PGE Registration:
• Schedule Type and corresponding data.
• Metadata Checks Objects for inputs to be checked.
• Metadata Definition objects specifying the type of metadata

parameter.

Use metadata of input data set to determine
whether a given PGE is to be run.
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“Metadata Activation” ODL Files
and Parameters

The following information needs to be filled out in the PGE  metadata  file for
each input with a metadata check:
• Object = Metadata_Checks
•     Parm_Name = <name of metadata parameter to check>
•     Operator = <operator on parameter value>
•     Value = <value to be checked against>
•     Database_Query = <get value from PDPS database; valid values are:
NONE, ORBIT NUMBER, PATH NUMBER, TILE ID, START DATA DAY END
DATA DAY>
• End Object = Metadata_Checks
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“Metadata Activation” ODL Files
and Parameters (CONT)

The following information needs to be filled out in the ESDT  metadata  file
for each input with a metadata check:
• Object = Metadata_Definition
•     Parm_Name = <name of metadata parameter to check>
•     Container_Name = <name of container or group that includes metadata
parameter>
•     Type = <type of parameter (int, float, string)>
• End Object = Metadata_Definition
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Metadata Query

Use metadata values to further refine the list of inputs acquired for
the PGE.

PGE-1 Output Dataset

Only get inputs where
metadata is set to 
“day”

  Input Dataset

Production Rule Information Needed for PGE Registration: 
• Schedule Type and corresponding data.
• Metadata Query Objects for inputs to be “refined”.
• Metadata Definition objects specifying the type of metadata parameter.
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“Metadata Query” ODL Files and
Parameters

The following information needs to be filled out in the PGE  metadata  file for
each input with a metadata query:
• Object = Metadata_Query
•     Parm_Name = <name of metadata parameter to query against>
•     Operator = <operator on parameter value>
•     Value = <value to be queried against>
•     Database_Query = <get value from PDPS database; valid values are:
NONE, ORBIT NUMBER, PATH NUMBER, TILE ID, START DATA DAY END
DATA DAY>
• End Object = Metadata_Query
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“Metadata Query” ODL Files and
Parameters (CONT)

The following information needs to be filled out in the ESDT  metadata  file
for each input with a metadata query:
• Object = Metadata_Definition
•     Parm_Name = <name of metadata parameter to query>
•     Container_Name = <name of container or group that includes metadata
parameter>
•     Type = <type of parameter (int, float, string)>
• End Object = Metadata_Definition
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Intermittent Execution

    Dataset 1 QA PGE Output Dataset

DAY 6:

    Dataset 1 QA PGE Output Dataset

DAY 11:

    Dataset 1 QA PGE Output Dataset

DAY 1:

run PGE on same data
set every five days

Production Rule Information Needed for PGE Registration:
• None -- this is specified by choices on the Production Request

Editor.

Run a PGE every Nth time it is able to be run.
Note this is different than the case of running a monthly average once every
 month (which is covered by the basic temporal rule)
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Special Level 0 Processin g Needs
(Orbital Processin g)

PGE-1 L1A Dataset

Run PGE when an 
orbit’s worth of data
is available

 EDOS L0 Data Set

 L1A start/stop times

 EDOS L0 Data Set

1 or more

Production Rule Information Needed for PGE Registration:
• PGE Schedule Type is “Orbit Scheduled”
• Orbit Model ODL file.
• Path Model ODL file (if path mapping desired).

Identify and stage proper input Level 0 data to produce 
Instrument Team defined Level 1A granules.
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“Orbit Scheduled” ODL Files and
Parameters

The following information needs to be filled out in the PGE  metadata  file:
• Schedule_Type = “Orbit”
• Processing_Boundary = “Start_Of_Orbit”
• Processing_Period = “Orbits=X” <where X is an integer value>

The following information needs to be filled out in the ORBIT  metadata  file:
• Platform = <platform of spacecraft>
• Orbit_Start = <start time of orbit>
• Orbit_Number = <number of orbit>
• Path_Number = <number of path (0-233) matching that orbit>
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Tilin g

Production Rule Information Needed for PGE Registration:
• PGE Schedule Type is “Tile Scheduled”
• Tile ODL file specified.

PGE-1 Output Dataset

Tile 1 Dataset

Tile 2 Dataset

Tile 3 Dataset

Identify and stage proper input data to produce
Instrument Team defined tiles.
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“Tile Scheduled” ODL Files and
Parameters

The following information needs to be filled out in the PGE  metadata  file:
• Schedule_Type = “Tile”
• Tile_Scheme = <name of tile scheme defined in Tile ODL file>

The following information needs to be filled out in the Tile  metadata  file:
• Tile_Scheme = <name of tile scheme>

For each tile:
• Object = Tile
• Tile_ID = <ID of tile>
• Tile_Description = <description of the tile>
• Coordinates = <the coordinates of the four (or more) corners of the tile>
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Data Day

Acquire data for a given Data Day.

PGE-1 Output Dataset

Only get inputs where
metadata is set to 
correct data day

  Input Dataset

pass PGE the Start
and End Data Day
values

Production Rule Information Needed for PGE Registration:
• PGE Schedule Type is “Time Scheduled”
• Create PCF Entry for Runtime parameters desired to have Start and
End Data Day specified.
• Create Metadata Query object for inputs that are to be requested by
Data Day.
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“Data Day” ODL Files and
Parameters

The following information needs to be filled out in the PGE  metadata  file for
each input that has to be retrieved by Data Day:
• Object = Metadata_Query
•     Parm_Name = <Data Day parameter name>
•     Operator = “>=“
•     Value = “0”
•     Database_Query = “START DATA DAY”
• End Object = Metadata_Query
• Object = Metadata_Query
•     Parm_Name = <Data Day parameter name>
•     Operator = “<=“
•     Value = “0”
•     Database_Query = “END DATA DAY”
• End Object = Metadata_Query
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“Data Day” ODL Files and
Parameters (CONT)

The following information needs to be filled out in the PGE  metadata  file.  A
PCF entry needs to be created for the runtime parameters that will specify
Start and End Data Day values.  The following parameter will allow PDPS to
populate the runtime parameters with the Start and End Data Days:
 Pge_Parameter_Dynamic_Value = “START DATA DAY”
or
• Pge_Parameter_Dynamic_Value = “END DATA DAY”
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“Data Day” ODL Files and
Parameters (CONT)

The following information needs to be filled out in the ESDT  metadata  file
for each input acquired by Data Day:
• Object = Metadata_Definition
•     Parm_Name = <name of Data Day parameter>
•     Container_Name = “AdditionalAttributes” (because Data Day is in a
PSA)
•     Type = string
• End Object = Metadata_Definition



118
625-CD-016-002

Final Notes

• Since the implementation of the Production Rules threads is
not yet complete, we cannot guarantee that there will not be
further refinements of the ODL templates.

• ODL templates can be found online at:
http://ecsinfo.hitc.com/iteams/iteams.html

• Detailed Production Rule Information

Detailed Production Rule Information are covered indepth in
publication:  MODIS Science Data Processing Software Version
2.0 System Description, SDST-104, dated May 19, 1998.
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DPREP

Introduction

This section contains information to run DPREP.

• DPREP is made up of three PGE’s each run
separately.

• The PGE’s are titled Step1 DPREP, Step 2
DPREPand Step 3 DPREP.

• The input files normally come from INGEST.

• These files are depicted in two of the three step
DPREP process in Table 12. DPREP Step 3 will be
available with Drop 5A.

• The output files generated from each of the DPREP
PGE’s contains Ancillary Attitude, and Ephemeris
data that becomes new inputs to Instrument PGE’s.
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DPREP Introduction continued

• These Instrument PGE’s will then process its
satellite data with similar time span files created
by DPREP.

• The DPREP registration process for each of the
three PGE’s creates in the Science Data Server
Archive a subscription for each of the DPREP
PGE’s.

• PGE execution then takes place in the PDPS.

• The SSI&T effort for DPREP PGE’s is similar in
effort to what would be required to register any
other PGE.
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SSI&T Activity for DPREP

• SSI&T Activity for DPREP

• The Level Zero datasets are received in 2 hour chunks.

• The file processes in Table 12 depicts the minimal time span
allowable for a DPREP run.  In a normal operation of DPREP,
a twenty four hour time span would be prepared for.  This
would require additional 2 hour chunks and thus additional
files of data would need to be registered.

• Before the registration process can take place, a number of files
will have to be updated to  process a block of data for a
particular time period.  Therefore, DPREP input files will have
to be identified and various templates for the SSI&T process
will require annotation.
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SSI&T Activity for DPREP Cont

• The sections that follow in the Training Manual  have been
highlighted with notations as to what SSI&T process applies in
the preparation of each template and the function required to
register each section.

• With a particular function identified, other portions of this
manual can be referred to for more detailed precedures to be
used to carry out the full SSI&T process.

• Whenever new input files are introduced or updated
executables are re-introduced it is wise to first set up the PGE
to run from the Command Line. This will determine if what
has been introduced will run error free.

• After a successful Command Line run it is advisable then to
complete the SSI&T effort to run from the PDPS.  Command
Line Runs include the use  the PCF to run from in the Science
Data Server.  PDPS runs include ESDT’s and ODL files to
generate internal PCF’s.
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DPREP File Processes
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DPREP Processes

DPREP Processes and Procedures
Processes and procedures are provided in the following
files on an SGI machine used to support SSI&T:

• DPREP README and HowToRunDPREP files
located at :/usr/ecs/TS1/CUSTOM/data/DPS/

• DPREP binary located:
:/usr/ecs/TS1/CUSTOM/bin/DPS/

DPREP consists of three pges each run separately.

1 The first step is a  ksh script called
EcDpPrAM1Step1DPREP, which serves as a driver
for three executables:

• EcDpPrAm1AncillaryDPREP

• EcDpPrAm1EphemerisGapFillDPREP

• EcDpPrAm1ToolkitToHdfDPREP

2 The second  step is EcDpPrAm1FddAttitudeDPREP.

3 The third step is
EcDpPrAm1FddReplaceEphemerisDPREP.
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Updatin g the PDPS Database
and  Data Server

Integration of Science Software with ECS requires that information about
PGEs be made known to the PDPS in its database.

• PDPS needs information to plan, schedule, and run science software.

• PDPS Database and  Data ServerTools are accessible from SSIT
Manager GUI.

Tools → PDPS Database   → PCF ODL Template
        → SSIT Science Metadata Update

        → SSIT Opnl  Metadata Update
Tools →   Data Server        → Register Subscription

         → Insert Static
        → Insert Test Dynamic
       → Insert EXE TAR
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Updatin g the PDPS Database
with ESDT Metadata

PDPS needs basic information on every type of file associated with PGEs.

• Metadata for the PDPS Database is first prepared in Object Definition
Language (ODL), one ODL file for each ESDT.

• Determine Science  Data Server ShortName for ESDT corresponding
to file.

• Search ESDT directory for ESDT ODL file.  If file exists, there is no
need to make another one for this ESDT. The file naming convention
is ESDT_ShortName .odl, where ShortName  is the same name used for
the Science Data Server.

• If not, copy the ESDT ODL template from configured area to user
space.

• Add required metadata to ODL file via text editor.
• ShortName in ODL file must match ShortName of file itself,

ShortName in ESDT descriptor, and ShortName in PGE metadata ODL
file.

• Copy the ESDT ODL file to the ECS configured area.
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Updatin g the PDPS Database
with PGE Metadata

PDPS needs basic information or metadata on the PGE.
Order for this Update PGE Metadata Activity:  It is recommended that all
ESDT metadata ODL files associated with the PGE be prepared and put
into the configured area before this procedure is executed.

Invoke PCF ODL Template Tool.

This tool prompts the user for the following information:
• Configuration file - use default ConfigFile path and filename for

DAAC
• Process Control File - Path and filename of PCF, default path is

current
• PGE Name - Name of PGE associated with PCF
• PGE Version - PGEversion, default  needs to be determined if not

known
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Updatin g the PDPS Database
with PGE Metadata  (cont.)

Many PCF ODL files can be made on same invocation until user quits.

Program outputs a file with name PGE_ PGEname#PGEversion .tpl.

Go to full path from which SSIT Manager is run and change this output
“.tpl” filename extension to “.odl” or copy template into file with same
name and “.odl”.

• Edit PGE_ PGEname#PGEversion .odl file to add metadata.
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Updatin g the PDPS Database
with PGE Metadata  (cont.)

Process Steps:
• From SSIT Manager select Tools  →  PDPS Database  →  SSIT

Science Metadata Update.

The program prompts for the following information:
• ConfigFile - use default for path and filename at each DAAC.
• mode - use default of ops.
• PGE name - name of PGE that will be registered (user choice).
• PGE version - PGE version to be registered.
• Quit out of program.

For Version 2 the mode corresponds to ops or TS1 PDPS Database.
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Updatin g the PDPS Database
with Operational Metadata

Assumption:
All ESDT metadata ODL files associated with the PGE must already be
prepared and put into the configured area and the PGE must be registered
using the Science Metadata Update Tool.

Process Steps:
• Invoke the PDPS/SSIT Database Update GUI Tool.
• Select the PGE name and version.
• Select new PGE and Done.  PDPS needs basic operational metadata

on the PGE to plan resources.
• Select Profile and enter values in fields under Performance Statistics:

    Wall clock time      CPU time
    Max memory used Block input ops
    Block output ops              Swaps
    Page faults
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Updatin g PDPS with Operational
Metadata

Process Steps (cont.):
• Select Resource Requirements and enter values:  Max disk space

used during PGE run.
• Select Proc. String.  Only one should be listed.  Number of Processors

should be 1.
• Select Apply to update the PDPS database.
• To start over, use RESET button.

The performance statistics collected by running the PGE under
EcDpPrRusage will be used to initialize the PDPS database so that the
Planning for DPRs can be performed.
The actual values entered can be approximate.
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Placin g Dynamic Data Granules
on the  Science Data Server

• A granule of data is the smallest aggregation of data that is
individually managed and archived in the ECS. When products are
requested through PDPS, the PGE will be run using the required input
data granules acquired from the  Science Data Server.

• Dynamic test data granules are delivered with the PGE for input at
runtime.

• Insert of dynamic test data is done by a Science Data Server Program.
• DAPs contain MCF templates or samples for output products, not

input.
• PGEs, through the SDP Toolkit, generate target MCFs for each data

granule produced using the source MCF ODL files delivered with the
PGE.

• The target MCFs produced by the PGE are used by the Data Server to
insert data products, thus they are called database load ODL files.

• SSI&T will have to create target MCFs (database load ODL files) for
input test data granules since they are not produced by a PGE.
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Creatin g a Target MCF for a
Dynamic Data Granule

Assumption: All ESDT metadata ODL files associated with the PGE must
already be prepared and put into the configured area and the PGE must be
registered using the SSIT Science Metadata Update Tool.
Process Steps to place dynamic data granules on the Science Data Server:

• If a source MCF template is not available for the dynamic data granule,
then make one by editing a template provided for SSI&T.

• Creating a target MCF for dynamic data granule from the source MCF.
- Go to the directory where the source MCF resides.
- Invoke SrcToTargetMCF program from command line.
- Enter source MCF filename (.mcf) and target MCF filename (.met).
- Edit TargetMCFfilename.met file.

• For all Data_Location=“PGE” attribute in Source MCF, enter data
values.

• Date values are provided by Instrument Teams on delivery of the DAP.
- Data granule start date/time and end date/time must be provided.

• Save the file.
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Insertin g Dynamic Data Granules
to the  Science Data Server

Process Steps for inserting  Dynamic Data Granules into the  Science Data
Server:

• Go to the directory where the dynamic data granule resides.
• From the SSIT Manager GUI →Tools → Data Server →  Insert Test

Dynamic.
• The Insert Test Dynamic program will be running.
• Enter the following information:

- ConfigFileName - use default.
- ESDT ShortName - ESDT ShortName corresponding to data

granule.
- Filename to Insert - Full path & filename of data granule to be

inserted.
- Associated ASCII metadata (target MCF) filename to Insert -

same as above filename but with “.met” extension.
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Placin g Static Data Granules on
the  Science Data Server

Static data granules are those whose temporal locality is static over long
periods of time. Examples are calibration files which change only with a
new  version of the PGE.
Static test data granules are delivered with some PGEs.

Source MCFs delivered with PGEs are treated as static data granules.

• Source MCFs delivered with PGEs can be used from the command line
to test a PGE, however an MCF will have to be generated from the
SDSRV for use in full PGE integration.

Insert of static test data is done by a Data Server Program in SSIT Manager.

DAPs contain MCF templates only for output products, not for input files.

PGEs, through the SDP Toolkit, generate target MCFs for each data granule
produced using the  MCF files generated by the SDSRV.
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Placin g Static Data Granules on
the  Science Data Server (cont.)

Target MCFs (database load ODL files) are needed to insert all data files,
including static data granules,  to the Science Data Server.

SSI&T will have to create target MCFs (database load ODL files) for static
data granules delivered for SSI&T since they are not produced by a PGE.

A template for static Metadata ODL files is provided for SSI&T.

The static version has parameters unlike those for dynamic data granules.
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Creatin g a Metadata ODL File for
a  Static Data Granule

Assumption: All ESDTs associated with the PGE, including either a single
ESDT for static type files or an ESDT for each static file,  must already be
registered. PGE must be registered using Science Metadata Update Tool.
A template metadata ODL file which can be edited is provided for SSI&T by
the instrument team.
Process Steps to place static data granules on the Data Server:

• Create a metadata ODL file for a static data granule.
- Go to the directory where the metadata ODL template resides.
- Copy StaticODLmet.tpl to the user work directory as filename .met.
- Edit the filename .met and enter the following information and save:

ShortName - ESDT ShortName
VersionID - ESDT VersionID
ParameterName - name of static file in
InformationContentContainer
ParameterValue - Cn: C = coefficient file, M = MCF; n = 1,2,...
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Insertin g Static Data Granules to
the  Data Server

Process Steps for inserting  Static Data Granules to the  Data Server:
• Go to the directory where the dynamic data granule resides.
• From the SSIT Manager GUI →Tools → Data Server →  Insert Static

The Insert Static program will be running.
• Enter the following information:

Config Filename - use default.
Mode - use default mode “ops”
ESDT ShortName - ESDT ShortName for data (bucket ESDT).
Science Group - Cn: C = coefficient file, M = MCF; n = 1,2,…
PGE Name - Name of PGE registered.
PGEVersion  - PGE version or take default of 1.
Filename to Insert - Filename of static data granule to be inserted.
Associated ASCII metadata (target MCF) filename to Insert - same
as the above filename but with “.met” extension.

• The static granule will be inserted. The program can run again until
the user quits.
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Insertin g Science Software
Executable on the Science Data

Server
All science software executables must be inserted on the  Data Server to
be run by the PDPS.  The executable package is called a SSEP or EXE Tar.
The steps of this procedure involve three activities:
Assembling a Science Software Executable Package:

- Make a new directory to hold the contents of the SSEP.
- Copy all files to go into the SSEP into this directory: PGE

executables shell scripts, SDP Toolkit message files.
- Use UNIX tar  to make the package

• Copy over the Target MCF template to filename .met, edit and save:
- The PGE name is PGEEXE.  Enter PGE version and parameter

values according to program prompt.
• Select from the SSIT Manager GUI:  Tools → Data Server →  Insert

EXE TAR.
- Enter PGE Name, SSWVersion, SSEPFileName, ExecFileName
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PGE Plannin g and Processin g

After the PGE has been linked to the DAAC Version of the SDP Toolkit, all
associated ESDT and PGE information has been entered into the PDPS
Database, all operational metadata has been entered, and the PGE has
been registered, then the PGE is ready to be run in PDPS under AutoSys.

The major steps in the PGE Planning and Processing are the following:
• Register a subscription for test input and output files (once per ESDT).
• Using the Production Request Editor, enter processing information

and submit a Production Request.
• Using the Planning Workbench, create a new production plan,

schedule the processing, activate the plan, and review the planning
timeline.

• Monitor production under AutoSys.
• Using the QA monitor, acquire and view the test output file from the

Data Server and examine the Production History File.



141
625-CD-016-002

Registerin g Subscriptions for
Test Input and Output Files

The Data Subscription Management application is used to manage the
receipt of a subscription notification from the  Data Server.

Process Steps:
• Invoke the Subscription Editor from the SSIT Manager.

• From the SSIT Manager GUI →
- Tools → Data Server →  Register Subscription

• Register a subscription for each of the input files and output product
files associated with the PGE.
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Usin g the Production Request
Editor

The Production Request Editor is a GUI tool which provides the
capabilities of submitting a Production Request (PR), looking at production
requests in the system, and viewing the Data Production Requests (DPRs)
which have been expanded from the original PR.

It is invoked from the command line as illistrated in two sections of the
accompaning Training Manual 625, titled: Creating a New Production
Request and  Using the Production Request Editor.

Only one PR can be submitted at a time by saving a PR file which is then
known to the Planning, Scheduling and Production System.  When a PR is
submitted, the windows are re-initialized and another PR can be submitted.
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The Production Request Editor
GUI

TAB DESCRIPTIONS
Planning - Displays a list of the four

capabilities provided by PR
Editor

PR Edit - Define and edit Production
Requests.

PR List - Displays a list of all PRs entered
into the system.

DPR View - Displays detailed information for
a selected DPR.

DPR List - Displays all DPRs associated
with a selected PR.
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Usin g the PR Edit GUI

Selecting the PR Edit tab at the top of the main Production Editor GUI.
The following information must be entered on the PR Edit screen:

• PR Name  - enter as New when PR is being done.
• Satellite Name - Name of spacecraft.
• Instrument Name- Name of Instrument for which data is being

processed.
• PGE Name - Name of the PGE registered in the system.
• PGE Version - Version of the PGE corresponding to PGE name.
• Originator - Name on Instrument Team or data provider.
• Priority - Priority to be assigned to this production request.
• StartDate - Start date for data coverage.
• StartTime - Start time for data coverage.
• EndDate - End date for data coverage.
• EndTime - End time for data coverage.
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PR Edit GUI
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Usin g the PR Edit GUI (2)

The PGE information is not entered directly into the PR Edit screen.  To
enter the PGE information, a pull down GUI is available by selecting
“PGE…”.   Selecting a PGE from this GUI, enters the related information
into the PR Edit screen.

If PGE Parameters are to be examined or changed, a pull down GUI is
available by selecting “PGE Parameters…”. The new value may be entered
in the override box in this GUI.

Entry of a comment is optional.

When the PR is complete, the “File” tab at the top is selected and a PR
filename is entered in the “Save As” box.
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PGE Selection GUI
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PGE Parameter Mappin g GUI
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PR List GUI
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DPR List GUI
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DPR View GUI
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Creatin g a New Production Plan

telnet to (PDPS)  odyssey or your PLN Host.  Use login ID: cmts1, PW:
ecsu$er,  dce_login awhitele awhitele,  setenv DISPLAY ….:0.0.  setenv
<mode>, and source EcCoEnvCsh, then follow instructions from Training
Manual, Monitoring Production in PDPS Subsystem.
The Planning Workbench is launched to bring up the Planning Workbench
GUI.  The following information is entered:

• File - set to New.  Plan Name - User name for plan.
• Status is CANDIDATE until plan is activated.
• Rollover Time - mm/dd/yy.
• Comment - Comments are optional.
• Production Request - Select one from the list of all PRs in the system.
• Schedule/Unschedule - select PR and down arrow  to schedule PR

from unscheduled list and vice versa to unschedule.
• Prioritize - Set priority.
• File - use “Save As”, to file under user specified PR name.
• Activate - Select to activate plan and enter date/time.
• Baseline - Select to create a new baseline plan.
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Plannin g Workbench GUI
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Review a Production Plan
Timeline

Launch the Planning Workbench and view the production plans.

Select the File and Open.
• This shows a list of Candidate, Active, and Baseline Production

Plans.

Select the desired Production Plan to view.
• The timeline for the selected Production Plan is displayed.
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Monitorin g Production

Monitor the PGE executions using AutoSys.

Process Steps:
• Launch AutoSys Monitor from the SSIT Manager
• Select the DPRs to be displayed in the AutoSys Job Activity Ops

Console Window.
• Select HostScape or TimeScape or JobScape for different views.
• View details of a single DPR.
• View the existing Event Report on the selected DPR.
• View processing alarms for a DPR.
• View job dependencies.
• Exit the AutoSys Monitor.
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AutoSys GUI Control Panel
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AutoXpert HostScape GUI
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AutoXpert Timescape GUI
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AutoXpert JobScape GUI
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Post Processin g Activities

Invoke the QA Monitor to view the products and select options.
• Select Query data and select or query on ESDT and Duration (time

range).
• Select Data Granule(s) to check and select Retrieve Data Granule.
• Production History Log files from PGEs run within PDPS.
• Find Data Granule and select Retrieve Production History.
• Examine Production History Log for metadata and other

information.
• EOSView

• Select Visualize Data.
• Select  Attributes to examine metadata in HDF headers.
• Select Table to view data vectors and matrices.
• If an image file is available, select Visualize.
• From the SSIT Manager GUI → Tools →Product Examination →

File Comparison →  EOSView or IDL.
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Science Product QA
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Postprocessin g  and General
Investi gation

Detection of Science Software Problems and ECS Problems.

• Examining PGE Log Files
•

• Investigate errors in Production History File.

• Use File comparison tools, EOSView and IDL to examine data
product problems .

•  Examine the PDPS Database with the Web Browser.

•  Submit problems using DDTS.


